
General Information

This is the information manager you've been looking for!    My Personal Diary lets anyone and everyone 
keep a private diary, journal or log for personal or business use, but that's not all.    Entries are stored in 
encrypted files with optional password protection and OLE support allows you to embed pictures, sounds 
and even other documents directly in your entries.    A    sophisticated search engine allows you to search 
any or all entries by date, for a word, sentence or phrase.    Add to this a complete address    book, to-do 
list and reminder system and you have a top notch information manager.

For HOME USERS,    My Personal Diary is an excellent way to keep track of day to day activities, 
thoughts, goals, feelings and to record the important events in your life.    Use the optional password 
protection to keep your entries safe from prying eyes.    Use OLE to embed pictures and sound clips in 
your entries.

For BUSINESS USERS,    My Personal Diary makes the ideal journal or log.    Easily keep track of daily 
activities, notes, contacts, to-do items and virtually any other type of free-form information.      Keep a 
separate journal for each client and store all notes, records and other    documents right in the journal.

For SCIENTISTS and STUDENTS,    My Personal Diary is the perfect log book.    Keep detailed, secure 
records of experiments and projects.    Create a separate log for each experiment or project and keep 
notes organized by date.    Use OLE to store charts, graphs and reports inside your log book.

For ANYONE,    My Personal Diary is a great tool to keep track of virtually any type of information.    Try it 
and you'll love it!

Features include:

· NEW! Multiple "pages" per entry.
· NEW! All new and improved organizer.
· NEW! Improved searching.
· NEW! Print Preview and Improved printing.
· NEW! Merge multiple diary files.
· NEW! Backup and Restore.
· NEW! Improved spell checker.
· NEW! Updated user interface.

· Works and feels like a real diary.
· Unlimited users can share the program on a single computer.
· Include pictures, sounds and OLE objects in your entries.
· Full support for text and paragraph formatting.
· Advanced Print, Preview, Search, Import and Export capabilities.
· Spell checker.
· Optional password protection and Lock options.
· Browse by date or by existing entry or quickly jump to any date.
· Powerful organizer with address book, to-do list, note pad and password vault.
· Complete on-line help.



Frequently Asked Questions

Q. How do I find out what version of MPD I currently have?
A. Start MPD then click About on the Help menu.    The exact version you have is shown there along with 

our logo and a link to the MPD web site.    If you do not see these you are looking in the wrong place.

Q. When upgrading to 2000 what happened to my user-defined entries?
A. Nothing.    They are now called Non-Dated entries and can be viewed by selecting "Non-Dated" in the 

combox next to the page tabs above the ruler.

Q. When upgrading to 2000 what happened to my password vault?
A. Since the password vault has been added to the organizer, when My Personal Diary 2000 opens a 

diary file created with an older version of MPD it saves the password vault in a text file in the program's
folder and displays a message about where the file is saved (if it exists).    You can import the 
password file into the new improved password vault and if you wish.

Q. I'm evaluating 2000 and I noticed that once I open my diary file with 2000 I cannot use it with V6.x any 
longer.    How can I go back to V6.x if I do not want to upgrade to 2000?

A. When you first open a diary file created with V6.x with 2000 it makes a copy of the file and names it 
with the extension .ddf.V6x    You can remove the .V6x from the name (you will need to rename or 
delete your existing 2000 diary file first) and open it with V6.x. Any changes you make with 2000 are 
NOT saved into this file.

Q. I have been using a previous version of My Personal Diary (prior to V6.0) and I just upgraded.    How 
do I import my entries into the new version?

A. Use the Diary Conversion Wizard.    The diary conversion wizard is a separate program available on 
our web site used to convert your existing entries.    You can import a diary created with any Windows 
3.1 version and the Windows 95 versions V5.x.    If you upgraded from V6.x you DO NOT need to 
use the DCW.    Your diary file is compatible with this version.  See the online help for more 
information.

Q. I forgot my password, what should I do?
A. If there was an easy way around your password then using a password would not make sense.    If you 

forget your password, kiss your entries good-bye.

Q. What type of encryption is used in My Personal Diary to encrypt my entries?
A. The encryption used is a proprietary method that is suitable for securing data for 99% of users.    It is 

not designed to be ultra-secure so additional steps should be taken to ensure privacy of extremely 
sensitive data.    It is next to impossible for anyone short of an expert to decrypt your entries.

Q. When I switch to a date that an entry does not exist for, the current date is inserted.    I want the date of
the entry to be inserted instead.    How do I do this?

A. There is an option in the configuration "Use the entry date..." on the Date/Time page.    You can also 
choose to insert the date, time, both or neither there.

Q. When I create a new entry the date and/or time are inserted automatically, but I don't like the format.    
What should I do?

A. MPD uses the date and time formats specified in Control Panel's Regional applet.    Set the date and/or
time format there.



Opening a Diary

To open a diary perform the following steps:

1.    Start My Personal Diary

2.    Enter your first name (this allows you to see a list of files you opened recently).

3.    Select the active diary file from the drop down list or click the Browse button to select another file.

4.    Enter your password (leave it blank if you do not require a password)

5.    Click OK.

If you do not have a dairy file already created or you want to create a new diary click the Create New 
button and see Creating a New Diary

How to bypass the Open Diary screen

To avoid the Open Diary screen each time you start My Personal Diary you can create a shortcut to your 
diary and specify your diary filename and password on the command line.    When you select the shortcut 
it will start My Personal Diary and open the selected diary file.

The format of the command line is as follows:

MPD.EXE diaryfile password 

* diaryfile and password are optional

If you do not use a password with diary you only need to specify diaryfile and leave password blank.

For more information on creating shortcuts see the Windows documentation.

Notes:

By creating a shortcut to your diary and specifying your password you are making your diary 
available to anyone who has access to your computer.



Creating a New Diary

The first time you use My Personal Diary you will need to create a new diary file to store your diary 
entries.

If you have an existing diary from a previous version of My Personal Dairy (prior to V6.0) you will want to 
use the Diary Conversion Wizard to convert it.    See Importing Entries.

To create a new diary perform the following steps:

1.    Start My Personal Diary.

*    Make sure you do not have a diary file and password specified on the command line.    If you do 
the Open Diary screen will not be displayed and you will not have the option of creating a new 
diary.

2.    At the Open Diary screen click the Create New button.

3.    Click the    button to specify a filename for your diary file.

*    Select the directory then type in a filename (Example: Diary.DDF)
*    Be careful not to specify and overwrite an existing diary.

4.    Enter your first name.

*    Do not include any spaces or special characters (Example: Bob).

5.    Enter a password.

*    If you do not want to use a password, leave the password prompt blank.

6.    Verify the password by entering it again.

7.    Click OK.



Paragraph Formatting

Select Format|Font or Format|Paragraph or Format|Tabs

Paragraph formatting options include font, left and right indents, tab stops and alignment.    

You can also perform all formatting quickly using the format toolbar and the ruler.

Font

The Font screen allows you to change the font, size, color and style of selected text.

To change the font perform the following steps:

1.    Select the text you wish to format.

2.    Select Format|Font.

3.    Select the font, size and color.

4.    Click OK.

Paragraph

The paragraph screen allows you to change the paragraph properties, including alignment, indents and 
bullets.

To format a paragraph perform the following steps:

1.    Move the cursor to the paragraph you wish to format or select multiple paragraphs.

2.    Select Format|Paragraph.

3.    Enter the paragraph indents.

*    It is much easier to use the ruler to set the paragraph indents.    Enter them manually when 
greater precision is required..

3.    Select the paragraph alignment.

3.    Check the Bullet checkbox to display bullets.

4.    Click OK.

Tabs

The tabs screen box allows you to change the tab stop positions.

To add a tab stop perform the following steps:



1.    Enter the position (in inches) of the tab stop from the left side of the page.

2.    Click the Add button.

*    The new tab stop will be added to the tab list if there is not already a tab stop at that position.

To remove a tab stop perform the following steps:

1.    Select the tab stop in the tab list.

2.    Click the Delete button.



Creating a New Entry

To create an entry for a given date perform the following steps:

1.    Use the Browse commands to get to the desired date for the entry you want to create.

2.    Type the text for your entry.

3.    Select File|Save.



Opening an Existing Entry

      Select File|Open…

To open an existing entry perform the following:

1.    Select File|Open.

2.    Select the entry you want to open.    Entries are listed in tree format, by date.

3.    Click OK.



Saving an Entry

      Select File|Save

To save an entry you only need to select Save on the File menu.    Your entries are automatically saved 
within your diary file.

Notes:

You can automatically save your entries without being prompted by choosing the Auto Save under 
Options on the View menu.

My Personal Diary will always ask you if you want to save your file if you attempt to close it or exit the 
program.



Deleting An Entry

Select File|Delete Entry

To delete an entry perform the following steps:

1.    Use the Browse commands to get to the desired date for the entry you want to create.

2.    Select File|Delete Entry

Notes:

Once you delete an entry it is gone forever.    Use this command with great care.



Printing Entries

      Select File|Print...

My Personal Diary includes a print engine at can print selected entries in a variety of ways.

To print entries perform the following steps:

1.    Select File|Print...

2.    Select the entries you want to print.

3.    Choose the print options (click the Setup button for additional options).

4.    Click the Preview button to see a preview or the Print button to print without a preview.

Notes:

When you print more than one entry you can choose to start each entry on a new page by checking the 
Start each entry on a new page checkbox.    Without checking this checkbox all entries are printed 
continuously with a few blank lines between each.

Check the Print entry dates checkbox to print the entry date at the beginning of each entry.



Diary Pages and Non-Dated Entries

Introduction

Pages are sub-entries in a diary file that help you keep different types of information separated for each 
date.    When you create a diary a tab named "Default Page" is automatically created as your first diary 
page.    This page cannot be deleted.

For example, you may have a "General" page, a "Meals" page and an "Exercise" page.    In this case, 
each entry in the diary on the Dated combobox item will have 3 pages titled General, Meals and Exercise.

You select a page by choosing the Dated combobox item above the editor and selecting the tab for the 
page you want to work with.

Non-Dated Entries are entries that are not tied to a specific date.    When you create a diary a tab named
"Default Non-Dated" is automatically created.    This entry cannot be deleted.    There are also 19 other 
non-dated entries created named Non-Dated 1, Non-dated 2 and so on    These, with the default non-
dated entry correspond to the 20 user-defined entries in previous versions and can be deleted.    
Additional entries can also be created.

For example, you can have a "General" entry and an "Ideas" entry.    In this case there will be two tabs 
when you select the Non-Dated combobox item.

You select a non-dated entry by choosing the Non-Dated combobox item above the editor and selecting 
the non-dated entry you want to work with.

Pages

Select the Dated combobox item then...

Select File|Pages|New or File|Pages|Delete Selected or File|Pages|Rename Selected

To create a new page perform the following steps:

1.    Select File|Pages|New...

2.    Enter the title for the page.

3.    Click the OK button.

To delete a page perform the following steps:

1.    Select the page you want to delete by clicking on the appropriate tab.

2.    Select File|Pages|Delete Selected.

To rename a page perform the following steps:



1.    Select the page you want to delete by clicking on the appropriate tab.

2.    Select File|Pages|Rename Selected....

3.    Enter the new title for the page.

4.    Click the OK button.

Non-Dated Entries

Select the Non-Dated combobox item then...

Select File|Non-Dated Entries|New or File|Non-Dated Entries|Delete Selected or File|Non-Dated 
Entries|Rename Selected

To create a new non-dated entry perform the following steps:

1.    Select File|Non-Dated Entry|New...

2.    Enter the title for the entry.

3.    Click the OK button.

To delete a non-dated entry    perform the following steps:

1.    Select the page you want to delete by clicking on the appropriate tab.

2.    Select File|Non-Dated Entry|Delete Selected.

To rename a non-dated entry perform the following steps:

1.    Select the page you want to delete by clicking on the appropriate tab.

2.    Select File|Non-Dated Entry|Rename Selected...

3.    Enter the new title for the entry.

4.    Click the OK button.



Browsing Entries

Browsing

My Personal Diary is designed to feel like a real diary in that you can browse through your entries as if 
you were turning the pages of an old fashion paper book diary.    You can use the commands on the 
Browse menu or the browser toolbar to browse by date and by entry. You can move forward and 
backwards in intervals of days, months or years or move to the first, last, next or previous entry.

Jumping to a Specific Date

The Today command will quickly bring you to the current date.

You can jump directly to any date by using the Other Date command on the browse menu or the  button.   
Simply choose the month and year in the pick date screen, then click the desired day on the calendar.    
You will jump directly to the date you selected and if an entry exists for that day it will be opened.

Notes:

The dates that entries exist for are a blue on the pick date screen.



Searching Entries

      Select Edit|Find...

The Find command allows you to search through multiple entries for search text.

To search for text perform the following steps:

1.    Select Edit|Find...

2.    Select the entries you want to search.

3.    Enter the search text or choose a category from the drop down list.

*    Categories are defined using the Category command on the Insert menu.
*    Check the Case Sensitive checkbox if you want the search to be case sensitive.
*    Check the Match Whole Words only checkbox to only match whole words.

4.    Click the New Search button to start a new search.

*    Each entry is opened and the first occurrence of the search text is highlighted.

*    Click the Find Next    button to find the next occurrence of the search text.

*    Check the Next Entry    checkbox if you want to skip to the next entry that contains the search 
text when you click Find Next (otherwise the next occurrence within the same entry will be 
highlighted).

*    To generate a list of entries that contain the search text without displaying each check the Log 
entries found below, then click the Find All button



Inserting Pictures, Sounds and Other Objects

      Select Insert|Object from File or Insert|Other Object

Using OLE you can insert pictures, sounds and other OLE objects into your entries.

To insert an OLE object into your entry perform the following steps:

1.    Select Insert|Object from File or Insert|Other Object

2.    Choose the object you want to insert.

3.    Click OK.

Notes:

You can paste objects that are on the clipboard into your entries.    For example, you can copy a picture 
from your favorite graphics program and paste it directly into your diary.

Pictures, sounds and other OLE objects can be very large.    The more objects you insert into an entry the 
larger your diary file will become and the longer it will take to load and save the entry. 



Inserting a Custom String or Category

        
      Select Insert|Custom Text or Insert|Category

A custom string is a phrase that you can store for quick insertion in your entries.

A category is a tag that can be used to categorize information within entries.    Categories are easily 
searched for using the Find command.

Since custom strings and categories are very similar they are covered together below

To insert a custom string perform the following steps:

1.    Select Insert|Custom Text...

2.    Select the string from the list.

3.    Click the Insert button to insert the string.

4.    Click the Close button.

To insert a category perform the following steps:

1.    Select Insert|Category...

2.    Select the category from the list.

Adding a Custom String/Category

1.    Click the New button.

2.    Enter the text in the edit control below the list.

*    For custom strings you can insert macros representing the entry date, the current date and the 
current time using the appropriate Macro button. These macros are expanded when you insert 
the custom string into your entry.

*    Custom strings can be more than one line. To insert a new line press ENTER.

3.    Click the Add button.

Deleting a Custom String/Category

1.    Select the custom string/category in the list.

2.    Click the Delete button.

Changing a Custom String/Category



1.    Select the custom string/category in the list.

2.    Edit the string/category in the edit control below the list.

3.    Click the Change button.

Reordering the Custom String/Category List

1.    Select the custom string/category in the list.

2.    Click the Up or Down button to move the item up or down.



Inserting the Date and/or Time

      Select Insert|Date or Insert|Time or Insert|Date and Time

To insert the date, time or both perform the following steps:

1.    Select the appropriate command on the Insert menu.

Notes:

The format of the date and whether the entry date or the current date is used, is determined by the 
settings on the Date and Time page in the configuration.



Changing Your Name/Password

Select Tool|Change Name and Password…

The name and password utility allows you to change the name used with your diary as well as your 
password.    You can also clear the list of files listed on the Open Diary screen for your name.

To change your name perform the following steps:

1.    Select Tool|Change Name and Password...

2.    Enter your new name in the name section

3.    Click the Change button in the name section.

To change your password perform the following steps:

1.    Select Tool|Change Name and Password...

2.    Enter your existing password in the password section.

3.    Enter your new password in the password section.

4.    Verify your new password by entering it again.

5.    Click the Change button in the password section.

To clear the files listed in the Open Diary screen for your name click the Clear File List In Open Dialog 
button.    All files except the currently open diary will be removed from the list.    This does NOT actually 
delete the files.    It only the removes the filenames in the most recently used list.

Notes:

After changing your password ALL entries are modified and any previous backups you have are obsolete. 
MAKE A NEW BACKUP IMMEDIATELY AFTER CHANGING YOUR PASSWORD.

The next time you log in after changing your password you will need to use your new password.    YOUR 
OLD PASSWORD WILL NO LONGER WORK.    REMEMBER YOUR NEW PASSWORD.



Importing Entries

Importing a Diary Entries from Another Program

You can import TXT and RTF files created with another program using the import command.    See below 
for information on importing diaries created with previous versions of My Personal Diary.

Select Tool|Import...

To import a diary in TXT or RTF format into the diary you currently have open perform the following steps:

1.    Select the diary page you want to import into.

*    The Import command is only available if a dated entry page is selected.

2.    Select Tool|Import...

3.    Select the format (TXT or RTF).

4.    Click the  button to select the folder that contains your TXT or RTF files.

5.    Choose the overwrite option.

* Prompt will prompt you for an action when an entry already exists in your diary.
* Never will skip all entries that already exist.
* Always will always overwrite any entries that already exist in your diary without prompting.

Notes:

To import a diary in TXT or RTF format, your existing entries MUST reside in a single directory, in 
separate files, with the following naming convention:

YYYYMMDD.TXT or YYYYMMDD.RTF

where:

YYYY is the year (Example: 1997)
MM is the month (Example: 01)
DD is the day (Example: 01)

An text entry for January 1,    1997 (1/1/97) would be named 19970101.TXT

Importing a Diary from My Personal Diary V4.x or V5.x

IF YOU ARE UPGRADING FROM V6.0 OR LATER YOU DO NOT NEED TO IMPORT YOUR DIARY.    
IT WILL WORK WITH THIS VERSION UNMODIFIED, JUST CLICK BROWSE ON THE OPEN DIARY 
SCREEN TO SELECT THE DIARY, THEN ENTER YOUR PASSWORD.

My Personal Diary has come a long way since it was first released for Windows 3.1    Many changes and
enhancements have been made and the structure of the diary has changed.    As a result you will need to 
use the Dairy Conversion Wizard to convert your existing diary created with any version prior to V6.0.



The Diary Conversion Wizard is a separate program (DCONVERT.EXE) that is available on our web site 
that you can use to:

- Import diaries created with the Windows 3.1 version of My Personal Diary (V4.x)
- Import diaries created with the Windows 95 version of My Personal Diary (V5.x)
 

To use the Diary Conversion Wizard perform the following steps:

1.    Make sure you are not running My Personal Diary.

2.    Start Diary Conversion Wizard 

3.    Follow the instruction in the wizard.



Exporting Entries

Select Tool|Export…

The Export… command allows you to save any or all entries as plain text or RTF (Rich Text).

To export entries perform the following steps:

1.    Select Tool|Export…

2.    Select the entries you want to export

3.    Choose the export options

4.    Click the Export button.

Notes:    

Exported files are saved to the Exported folder in the program folder.

When you export more than one entry you can choose to export each entry to a separate file by checking 
the Export each entry to a separate file checkbox.    Without checking this checkbox all entries are 
exported continuously with a few blank lines between each to a single file.

Check the Include entry dates checkbox to include the entry date at the beginning of each entry.



Backing Up and Restoring

Select Tool|Backup and Restore...

The Backup and Restore command allows you to easily backup and restore your diary file to a floppy disk
or any other drive on your computer.    Backing up is a VERY important step in making sure your diary file 
is safe.    Should your computer crash you will always have a recent copy of you diary file that can easily 
be restored from the Open Diary screen.

Backup

To backup your diary file perform the following steps:

1.    Select Tool|Backup and Restore...

2.    Click the  button to select the location to store your backup.

*    The default folder can be specified under Options on the View menu so you do not need to 
specify it each time you backup.

3.    Insert a disk into the drive you are backing up to (if required).

4.    Click the Backup Now button.

Restore

To restore your diary file perform the following steps:

1.    Start My Personal Diary and click Restore at the Open Diary screen.
.

*    If MPD is already running and you have another diary file open select Tool|Backup and Restore.. 
then click on the Restore tab instead.

2.    Insert a disk into the drive you are restoring from (if required).

3.    Click the  button to select the backup file to restore.

4.    Click the Restore Now button.



Merging Diaries

Select Tool|Merge...

The Merge… command allows you to merge entries from another diary into the currently open diary.

To merge entries from another diary into the currently open diary perform the following steps:

1.    Select ToolMerge...

2.    Click the  button to select the diary file you want to merge in.

3.    Enter the password for the diary if it uses one.

4.    Click the Open Diary and Select Entries button to open the diary and fill the entry list with the 
available entries.

5.    Select the entries you want to merge in the entry list.    Multiple entries can be selected using the Shift 
and Ctrl keys.

6.    Choose the overwrite option.

* Only When Newer will overwrite any entries that already exist in your diary and are older than the 
one being merged in without prompting.

* Prompt will prompt you for an action when an entry already exists in your diary.
* Never will skip all entries that already exist.
* Always will always overwrite any entries that already exist in your diary without prompting.



Spell Checking an Entry

      Select Tool|Spell Check

The built in spell checker allows you to check the spelling of words in your entries.

Checking an Entire Entry

Make sure no text is selected and select Tool|Spell Check.

Checking a Section in an Entry

Select the text you wish to check and select Tool|Spell Check.



Choosing Multiple Entries

All screens that allow you to select multiple entries have the  button to open the Choose Entries screen 
and allow you to select individual entries.

To choose multiple entries perform the following steps:

1.    Click the  button.

2.    Drag and Drop entries to and from the Selected Entries list to add or remove them to the selection or 
click the  button to select the entries from the last search

*    You can press and hold the SHIFT or CTRL key to select and drag multiple entries at once.

3.    Click OK.

Notes:    

You can drag and drop entries within the Selected Entries list to change their order and the order in which
they are processed.



Selecting Entries

Many screens require that multiple entries be selected for searching, printing, exporting, etc.    All these 
screens use the same set of buttons and a list box for easy selection of entries.

    This button adds all entries (on all pages) to the entry list.

    This button adds all entries on the current page to the entry list.

    This button allows you to pick individual entries. See Choosing Multiple Entries

    This button clears the entry list so that only the current entry is processed.

Notes:    

You can drag and drop entries in the entry list to change their order and the order in which they are 
processed.



Options
Select View|Options

General Options

Auto-save entries every ___ minutes
Check this checkbox to automatically save at the interval you specify and when switching between 
entries without prompting.

Create a backup each time a diary is opened
Check this checkbox create a backup copy of the diary file before it is opened.    This is useful for 
reverting back to the state your diary was in before you last opened it.

Prompt to backup to removable media each time I exit
Check this checkbox to automatically prompt you to backup your diary file each time you exit.

Default backup folder
Select the default location to store your backup file.

Hide in the system tray instead of closing
Check this checkbox to hide the main window instead of closing it entirely when you click the close 
(X) button on the caption bar.    You can still close the program entirely by clicking Exit on the File 
menu.

Automatically lock diary when hidden in the system tray
Check this checkbox to automatically lock the diary when it is hidden in the system tray.    To open the 
diary again you must enter the password.

Automatically show the to-do list when opening a diary
Check this checkbox to automatically open and display your to-do list when you open your diary.

Only if there are reminders
Check this checkbox to automatically open and display your to-do list ONLY if there are reminders 
waiting when you open your diary (and the above option is checked). 

Date and Time Options

Insert the date into all new entries
Check this checkbox to insert the date into each new entry.

Insert the time into all new entries
Check this checkbox to insert the time into each new entry.

Use the entry date instead of the actual date when inserting dates
Check this checkbox to use the date of the entry instead of the actual date when inserting a date into 
an entry.

Use Long Dates instead of Short Dates
Check this checkbox to use the long form of the date (ie. Monday, January 4, 1999) instead of the 
short form (ie. 1/3/99).



*** Note: The format of the date and time is set in Control Panel's Regional Settings applet.

New Entry Defaults Options

Font
Select the font, size, color and style that is used as the default for all new entries.

Paragraph
Select the margins, alignment and numbering that is used as the default used for all new entries.

Appearance Options

Show ruler
Check this checkbox to show the ruler on the main screen.

Show title
Check this checkbox to show the title that displays the entry date on the main screen.

Show cover
Check this checkbox to show the book cover and spline.    Checking this options gives the main 
screen a look like a real book.

Title Color
Select the title color

Title Text Color
Select the color of the text on the title.

Cover Color
Select the color of the diary cover.

Editor Background Color
Select the editor's background color.

Spell Checker Options

See Spell Checking Options



Registration Wizard Help

The Registration Wizard guides you through the process of registering our products.

If you have trouble ordering or have any questions please contact us at:

sales@camdevelopment.com



Spell Check

The spell check dialog provides many useful options for easily locating misspelled words and correcting 
them.    Many different configuration options are also available (see Spell Check Configuration for more 
details).

The Change All button will replace all occurrences of the misspelled word with the word in the "Replace 
With:" edit field, while the Change button replaces only the current occurrence of the misspelled word. 

The Ignore All button will ignore the word thought to be misspelled throughout the rest of the spell check, 
while the Ignore button will only ignore the current occurrence. 

The Add button adds the word in the "Not Found:" edit field to the user dictionary.

The Auto-Correct button adds the words in the "Not Found" edit field and the "Replace With" edit field to 
the current user dictionary as an auto-correct pair.    Any future occurrence of the presumed misspelled 
word will then be replaced with the correct spelling automatically.    This is useful for common spelling 
mistakes, such as recieve:receive and teh:the. 

The Suggest button will, if possible, add additional word alternatives to the suggestions list. 

The Start button is used to restart a spell check session from the current cursor position if the spell check 
window lost focus in favor of another window in the current application.    This gives freedom of 
movement, allowing you to edit the document being checked without ending the current spell check 
session. 

The Undo Last button restores the last spell check action performed and reselects the previous 
misspelled word (if possible).    This button can be pressed multiple times to undo multiple operations.

The Options button shows a window allowing you to set spell check configuration options



Spell Checking Dictionaries

This tab of the configuration window controls which main dictionaries and user dictionaries are active 
during the spell check.

In both the main and user dictionary lists the checkbox to the left of the item indicates whether or not a 
specific dictionary is active.    To change the active status, simply click on this checkbox. 

To add an already existing dictionary to the list, click on the Add button.    When adding a pre-existing user
dictionary, Microsoft Word user dictionaries (.DIC file extension) may also be used.    To delete a dictionary
already in the list, click on the Remove button. 

To form a new user dictionary, click on the New button.

The "Add Words To" selection box lets you specify which user dictionary new words and auto-corrections 
are to be added to.    This must be an active user dictionary (and not a Microsoft Word user dictionary).

The OK button saves the current configuration and closes the configuration window. 

The Cancel button aborts any changes made to the configuration and closes the configuration window.

See Also: Spell Checking Options



Spell Checking Options

This tab of the configuration window controls specific configuration options related to the spell check.

Ignore Options:

The Words in UPPERCASE checkbox, when checked, forces the spelling checker to skip any words 
completely in uppercase.    This can be useful for ignoring abbreviations.

The Words Containing Numbers checkbox, when checked, forces the spelling checker to skip any words 
that may contain one or more numeric characters.    This can be useful for ignoring license plates and 
other partially numeric words.    This can also be somewhat detrimental if a numeric key was pressed 
instead of a character by mistake.

The HTML Tags checkbox, when checked, forces the spelling checker to skip any HTML tags 
encountered (i.e. text between opening and closing angle brackets).

The URLs and E-mail Addresses checkbox, when checked, forces the spelling checker to skip any e-mail 
addresses or world wide web addresses found in the document.

The Reset Ignore All button removes any words previously added to the "Ignore All" list.    Words 
previously in the list will no longer be ignored when encountered.

The Reset Change All button removes any word sequences added to the "Change All" list.    Words 
matching added to the "Change All" list will no longer be automatically replaced. 

Suggest Options: 

The Generate Automatically checkbox, when checked, forces the spelling checker to make suggestions 
for replacement of a word as soon as a misspelled word is located.    If this option is not checked, no 
suggestions are given initially.

The From Primary Dictionary Only checkbox, when checked, forces all suggestions to be constructed 
from the primary dictionary only.    If the option is not checked, then suggestions are generated from each 
main dictionary.    The primary dictionary is the first dictionary in the main dictionaries list

General Options: 

The Re-check Replaced Words checkbox, when checked, forces the spell checker to re-check words that 
it has replaced as a result of a change or change all operation.    This is a useful feature to counteract the 
occasional spelling mistake that may occur when typing a corrected word.

The OK button saves the current configuration and closes the configuration window. 

The Cancel button aborts any changes made to the configuration and closes the configuration window.



See Also: Spell Checking Dictionaries



Word Not Found

This field simply displays the word that is currently thought to be misspelled.



Replace With Word

This edit field contains the word that the misspelled word is to be replaced with.    To change this field, 
simply click on a word suggestion in the suggestions list, or edit the field directly.



Suggestions List

This list generally contains several correctly spelled words each thought to be a possible replacement for 
the misspelled word.    To select a word for replacement, simply click on that word.    Double clicking on a 
word will replace the current and all future instances of the misspelled word with the suggestion clicked 
upon (Change All).



Suggest Button

If suggestions are not generated automatically (a configuration option), then pressing this button initially 
will add suggestions for the misspelled word to the suggestions list.    From this point, the suggest button 
will generate more suggestions for the currently selected word in the suggestions list.



Start Button

This button is used to restart a spell check session from the current cursor position of the document being
checked if the spell check window lost focus in favor of another window in the current application.    This 
gives freedom of movement, allowing editing of the document being checked without ending the current 
spell-check session.



Undo Last Button

This button will restore the last spell check action performed and reselect the previous misspelled word (if 
possible).    This button can be pressed multiple times to undo multiple operations.



Options Button

This button will show a window allowing you to set which main and user dictionaries are active, as well as 
several other configuration options.



Change All Button

This button replaces the current and all successive instances of the misspelled word with the word in the 
"Replace With" edit field.



Change Button

The button replaces only the current instance of the misspelled word with the word in the "Replace With" 
edit field.    Any successive instances of the misspelled word will not be replaced.



Ignore All Button

This button will force the spell checker to ignore all future instances of the misspelled word in the current 
spell check session.    Future sessions will not ignore the word.



Ignore Button

This button will force the spell checker to ignore the current instance of the misspelled word.    Future 
instances will not be ignored.



Add Button

This button adds the word thought to be misspelled to the currently active user dictionary (specified in the 
configuration).    Any future occurrences of the word will be ignored, provided the user dictionary it was 
added to is active.



Auto-Correct Button

This button adds an auto-correction pair to the active user dictionary (specified in the configuration).    This
will force the current and any future occurrence of the misspelled word to be replaced with the word 
specified.



Cancel Button

This button closes the spell check window and ends the current spell check session.



Up and Down Buttons

These buttons move the selected main dictionary up and down in the main dictionary list.    This is 
important for several reasons.    The main dictionary that is first in the list is considered the primary 
dictionary.    The order of dictionaries in the list is also the order which they are searched, so the most 
frequently used language should be first in the list.



Main Dictionary List

This list shows the main dictionaries that are known to the system.    The checkbox to the left of the item 
indicates whether or not a specific dictionary is active.    To change the active status, simply click on this 
checkbox.    The main dictionary that is first in the list is considered the primary dictionary.    The order of 
dictionaries in the list is also the order which they are searched, so the most frequently used language 
should be first in the list.



Add Button

This button presents an open dialog for adding an existing main dictionary to the main dictionary list.



Remove Button

This button removes the currently selected main dictionary from the main dictionary list.    It is not 
removed from the computer, just the available dictionaries list.



Up and Down Buttons

These buttons move the selected user dictionary up and down in the main dictionary list.    The order of 
dictionaries in the list is also the order which they are searched, so the most frequently used user 
dictionary should be first in the list.



User Dictionary List

This list shows the user dictionaries that are known to the system.    The checkbox to the left of the item 
indicates whether or not a specific dictionary is active.    To change the active status, simply click on this 
checkbox.    The order of dictionaries in the list is also the order which they are searched, so the most 
frequently used user dictionary should be first in the list.



Add Button

This button presents an open dialog for adding an existing user dictionary to the user dictionary list. When
adding a pre-existing user dictionary, Microsoft Word user dictionaries (.DIC file extension) may also be 
used.



Remove Button

This button removes the selected user dictionary from the user dictionary list.



Add Words To:

This selection box lets you specify which user dictionary new words and auto-corrections are to be added 
to.    This must be an active user dictionary and cannot be a Microsoft Word user dictionary.



Ignore Upper Case Option

This option forces the spell checker to ignore all words that are fully uppercase.



Ignore Partial Numbers Option

This option forces the spell checker to ignore words that have embedded numeric characters within (in 
addition to alphabetic characters).



Generate Suggestions Automatically Option

This option forces the spelling checker to make suggestions for replacement of a word as soon as a 
misspelled word is located.    If this option is not checked, no suggestions are given initially.



Primary Dictionary Only Option

This option forces all suggestions to be constructed from the primary dictionary only.    If the option is not 
checked, then suggestions are generated from each main dictionary.    The primary dictionary is the first 
dictionary in the main dictionary list.



Re-check Replaced Words Option

This option forces the spelling checker to re-check words that it has replaced as a result of a change or 
change all operation.



OK Button

This button saves the current configuration and closes the configuration window.



Cancel Button

This button aborts any changes made to the current configuration and closes the configuration window.



New Button

This button adds a new user dictionary to the user dictionary list.



Reset Ignore All Button

This button clears the list of words the spell checker is ignoring for the current session.



Reset Change All Button

This button clears the list of words the spell checker is automatically changing for the current session.



Ignore HTML Tags

This option will force the spelling checker to ignore any text found within HTML tags encountered during 
the parse.



Ignore URLs and E-mail Addresses

This option forces the spelling checker to ignore common internet strings, such as URLs and e-mail 
addresses.



Using the Address Book

      Select Organizer|Address Book

The address book is designed to allow you to store names and addresses of people you know for easy 
access.    It also allows you to categorize contacts and print contacts in several different formats.

All functions are available from the main address book screen as shown below:

      Adding a Contact

Click the add button and enter the contacts properties.

      Deleting a Contact

Select the contact in the list and click the delete button.

      Editing a Contact's Properties

Select the contact in the list and click the properties button.

      Printing Contacts

To print contacts in a variety of formats click the print button.

      Compacting the Address Book

If you delete a lot of contacts from your address book and want to save space, select File|Compact to 
remove unused space from the data file.

      Importing Contacts

To import contacts from any comma delimited text file, select File|Import, then select the file and match 
the import fields.

      Exporting Contact

To export contacts to a comma delimited text file, select File|Export, then enter a filename.    You can then 
use the text file to import your contacts into another program.

      Filtering Contacts

The filtering features allow you to display any subset of your contacts in the contact list.    It works as a 
filter and a search in one powerful feature.    Select the GROUP you want to include and optionally select 
a field name, and enter search text, then click the filter button.



For example:    GROUP = Personal AND Last Name CONTAINS M    will display all contacts in the 
Personal group with a last name that contains M (or m).

Notes:

You can change the style of the contact list using the options on the view menu.

In details view you can size and order the columns in the contact list the way you want using drag and 
drop.

You can hide or move the toolbars and detail bar using drag and drop.



Contact Properties

      Select Edit|Contact Properties...

The contact properties consist of several pages of information for a contact as follows:

1. General Page

First Name The contact's first name
Last Name The contact's last name
Display Name The name displayed for the contact.    By default this is Last Name, First Name but 

can be changed to anything you wish.

Important Dates Important dates for the contact such as birthday, anniversary etc.    Use the Add, 
Change and Delete button to modify the dates listed.

2. Home Page

Personal information about the contact including address, e-mail address, web site and phone and FAX 
numbers.    Check the phone number you want to be the default.

3. Business Page

Business information about the contact including company, title, department, address, e-mail address, 
web site and phone and FAX numbers.    Check the phone number you want to be the default.

4. Notes Page

Additional notes about the contact.



Printing Contacts

      Select File|Print...

Contact information can be printed in a variety of formats.

To print contact information perform the following steps:

1.    Use the Filter options to display the contacts you want to print.

2.    Select File|Print...

3.    Choose what you want to print by selecting either the Address Book or Phone List tab then check the 
fields you want to include in the printout.

4.    Select the page layout.

5.    Select the text size.

*    Keep in mind that when choosing a small page layout some text size choices may be too large to
allow all the information to fit.    Choose a small size for these layouts.

6.    Choose the print options.

7.    Click the Preview button to see a preview or the Print button to print without a preview.



Importing Contacts

      Select File|Import...

The import feature allows you to import contacts from any text delimited file.

To import contacts perform the following steps:

1.    Select File|Import...

2.    Select the filename of the text file containing your contacts to import.

3.    Match the field names with the corresponding fields in the text file and click the add button to add the 
field to the import list.    Choose the most appropriate field for each field name.    Any fields you do not 
add will be ignored.

4. Click the Import button.



Picking Contacts

The address book filter options all you to select contacts by group or any field, but it also allows you to 
choose contacts individually for the greatest flexibility.

To pick contacts perform the following steps:

1.    Click the ... button on the Filter Bar..

2.    Drag and Drop entries to and from the Selected Contacts list to add or remove them to the selection.

*    You can press and hold the SHIFT or CTRL key to select and drag multiple entries at once.

3.    Click OK.



Using the To-Do List

      Select Organizer|To-Do List

The to-do list is designed to allow you to easily keep a list of to-do items.    You can set reminders and 
print to-do items in several different formats.

The Basics

When using the to-do list there are several terms and ideas that you should understand before continuing.

1.

All functions are available from the main to-do screen as shown below:

      Adding a To-Do Item

Click the add button and enter the to-do item properties.

      Deleting a To-Do Item

Select the To-Do Item in the list and click the delete button.

      Editing a To-Do Item's Properties

Select the to-do item in the list and click the properties button.

      Printing To-Do Items

To print to-do items in a variety of formats click the print button.

      Compacting the To-Do List

If you delete a lot of to-do items from your to-do list and want to save space, select File|Compact to 
remove unused space from the data file.

      Importing To-Do Items

To import to-do items from any comma delimited text file, select File|Import, then select the file and match 
the import fields.

      Exporting To-Do Items

To export to-do items to a comma delimited text file, select File|Export, then enter a filename.    You can 



then use the text file to import your to-do items into another program.

Notes:

You can change the style of the to-do list using the options on the view menu.

In details view you can size and order the columns in the to-do list the way you want using drag and drop.

You can hide or move the toolbars using drag and drop.



To-Do Items Properties

      Select Edit|Item Properties...

The to-do item properties consist of several pages of information for an item as follows:

1. General Page

Date The date the item is for or starts.
Priority The item's priority: Low, Medium or High.
Lead Time The value "No Reminder: or the number of days before an item is due that a reminder

is displayed.

Description The item's description.
Status The item's status: Pending or Complete.

2. Repeat Page

The Repeat page is used to specify the recurring properties for an item.    An item can either represent a 
one-time event or an event that repeats every X days, weeks, months or years forever or until a certain 
date.

Every The item's interval: Once, Weekdays, Days, Weeks, Months or Years.
Forever/Ending Check Forever or Ending and specify the end date for the item.

3. Notes Page

Additional notes about the to-do item.



Printing To-Do Items

      Select File|Print...

The to-do list can be printed in a variety of formats.

To print the to-do list perform the following steps:

1.    Select Daily View, then choose the date, week or month you want to print or start at.

2.    Select File|Print...

3.    Choose what you want to print.

4.    Select the page layout.

5.    Select the text size.

*    Keep in mind that when choosing a small page layout some text size choices may be too large to
allow all the information to fit.    Choose a small size for these layouts.

6.    Choose the print options.

7.    Click the Preview buttonClick the Preview button to see a preview or the Print button to print without a
preview.



Importing To-Do Items

      Select File|Import...

The import feature allows you to import to-do items from any text delimited file.

To import to-do items perform the following steps:

1.    Select File|Import...

2.    Select the filename of the text file containing your to-do items to import.

3.    Match the field names with the corresponding fields in the text file and click the add button to add the 
field to the import list.    Choose the most appropriate field for each field name.    Any fields you do not 
add will be ignored.

4. Click the Import button.



Compacting the To-Do List

      Select File|Compact...

Compacting the to-do list removed all items before a specified date, frees unused space in the data file 
and sorts records.

To compact the to-do list perform the following steps:

1.    Select File|Compact...

2.    Select the date you want to remove items before.

3.    Check the Remove Pending Items checkbox if you want to remove pending items before the date 
specified as well.

4.    Click the OK button.



Using the Note Pad

      Select Organizer|Notes

The notepad is a simple utility for keeping a series of note pages.    You can use it to store any 
miscellaneous information.

To edit a note page, use the browse buttons to open the desired page, then type to edit your notes for that
page.

All changes are automatically saved.



Using the Password Vault

      Select Organizer|Password Vault

The password vault is a secure place where you can store passwords and other information about your 
accounts for easy access.

To add an account to the vault perform the following steps:

1.    Click the + button.

2.    Enter the description, user ID, password and notes

3.    Click the Post button.

To change an account in the vault perform the following steps:

1.    Select the account you want to modify from the account list.

2.    Enter the description, user ID, password and notes

3.    Click the Post button.

To delete an account in the vault perform the following steps:

1.    Select the account you want to delete from the account list.

2.    Click the - button

To view information for an account simply select the account from the account list and the information is 
displayed.



Importing Passwords

The import feature allows you to import passwords and account information from any text delimited file.

To import passwords perform the following steps:

1.    Click the  button.

2.    Select the filename of the text file containing your passwords to import.

3.    Match the field names with the corresponding fields in the text file and click the add button to add the 
field to the import list.    Choose the most appropriate field for each field name.    Any fields you do not add 
will be ignored.

4. Click the Import button.




